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บทคัดยอ 

 

   

         ปญหาพิ เศษนี้  นํ าเสนอซอฟตแวรสําหรับตรวจจับความเร็วยานพาหนะในรูปแบบ          

แอปพลิเคชันเดสกท็อป โดยวัตถุประสงคคือ เพ่ือพัฒนาซอฟตแวรท่ีสามารถตรวจจับความเร็ว

ยานพาหนะ และนับจํานวนยานพาหนะที่วิ่งตามทองถนนได โดยจะใชเทคนิคของการประมวลผล

ภาพ และการคํานวณอัตราเร็ว โดยมีการนํา Visual Studio และ Qt Creator พัฒนาในสวนของ

ซอฟตแวรดวยภาษา C++ รวมกับไลบรารี OpenCV ซึ่งซอฟตแวรจะชวยใหสามารถทราบถึง

ความเร็วของยานพาหนะ และสามารถนับจํานวนยานพาหนะที่ผานในพ้ืนที่ที่กําหนดไว โดยผลการ

ทดลองพบวาซอฟตแวรนี้สามารถตรวจจับยานพาหนะไดหลากหลายประเภท แตยังพบวามีบาง

ประเภทที่ไมสามารถตรวจวัดความเร็วได เชน รถพวง โดยซอฟตแวรตรวจจับความเร็วที่พัฒนาข้ึนนี้ 

มีความคลาดเคลื่อนของคาความเร็วอยูที่ ± 2 กิโลเมตรตอชั่วโมง ซึ่งใชความหนวงเวลาในการ

แสดงผลประมาณ 1.087 วินาที 

 

คําสําคัญ : โอเพนซีว,ี คอมพิวเตอรวิชัน, การประมวลผลภาพดิจิทัล, อัตราเร็ว 

 

 

 

 

 

 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



ข 
 

Title                            Software for Vehicle Speed Detection 

Students  Mr. Pasit Khunthakhet  Student ID 56050324  

                                      Mr. Wuttipat Tuankum Student ID 56050378 

Degree                            Bachelor of Science (Computer Science)  

Department Computer Science 

Faculty Science 

University King Mongkut’s Institute of Technology Ladkrabang (KMITL)                                  

Academic Year 2016 

Advisor Asst.Prof.Dr.Warangkhana Kimpan 

 

 

Abstract 

 

          This special problem proposed vehicle speed detection software on desktop 

application. The objective is to develop the software for detecting the vehicle speed 

and counting the number of vehicles on the roads. It uses the principles of digital 

image processing and speed calculation formula in Physics. In development, this 

software used Visual Studio and Qt Creator using C++ language with OpenCV library. 

It will help the user in detecting the speed of vehicles and calculating the number of 

vehicles passing through the designed location.  The experimental results indicated 

that this software can detect vehicle speed of various types of vehicle. However, the 

software cannot detect the speed of some types of vehicles, such as trailers. The 

deviation of vehicle speed detection software is ± 2 km/h with 1.087 seconds of 

delay time. 
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กิตติกรรมประกาศ  
 

 รายงานสําหรับโครงงานปญหาพิเศษฉบับนี้สําเร็จลงไดดวยดีเนื่องดวยความอนุเคราะห

ชวยเหลือเปนอยางดีจากผูชวยศาสตราจารย ดร.วรางคณา กิ้มปาน อาจารยที่ปรึกษาที่คอยดูแลอยาง

ใกลชิด และประธานกรรมการสอบปญหาพิเศษ อาจารย วิสันต ตั้งวงษเจริญ และผูชวยศาสตราจารย 

กฤษฏา บุศรา กรรมการสอบปญหาพิเศษ ที่ไดสละเวลาในการแนะนํา ใหขอคิดเห็น ตรวจแกไขใน

การทําปญหาพิเศษใหสําเร็จลุลวงไปไดดวยดี พวกกระผมรูสึกซาบซึ้งในความกรุณาของอาจารยเปน

อยางยิ่งและขอกราบขอบพระคุณอาจารยทุกทานเปนอยางสูงไว ณ ที่นี้ 

 ขอขอบพระคุณคณาจารยในภาควิชาวิทยาการคอมพิวเตอร สถาบันเทคโนโลยีพระจอมเกลา

เจาคุณทหารลาดกระบังทุกทาน ที่คอยใหการอบรมสั่งสอน และไดใหความรูแกคณะผูจัดทําตลอด

ระยะเวลา 4 ปจนกระทั่งปญหาพิเศษสําเร็จลุลวงไปไดดวยดีทุกประการ ขอขอบคุณ รุนพ่ี เพ่ือนๆทุก

คนที่ใหคําปรึกษา แสดงความคิดเห็น รวมถึงใหกําลังใจที่ดีตลอดมา 

 สุดทายนี้พวกกระผมขอกราบพระคุณ คุณพอ คุณแม และคนในครอบครัวที่คอยเปนกําลังใจ

เสมอมาตลอดชวงเวลาที่ไดทําปญหาพิเศษนี ้
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บทท่ี 1  

บทนํา  
 

1.1 ความเปนมาและความสําคัญของปญหา  

 ปจจุบันอุบัติเหตุบนทองถนนเปนสิ่งที่ผูใชรถใชถนนไมปรารถนาใหเกิดมากที่สุด แมวาจะ

เกิดขึ้นคอนขางบอยก็ตาม สิ่งท่ีแยที่สุดคือผูใชรถใชถนนไมไดเรียนรูจากความผิดพลาดบนทองถนน  

ผูขับขี่สวนใหญเขาใจกฎจราจรทั่วไป และมาตรการดานความปลอดภัยขณะใชถนน แตก็มีผูขับข่ี

บางสวนที่ละเลย ซึ่งเปนสาเหตุของการเกิดอุบัติเหตุ สวนใหญอุบัติเหตุรายแรงเกิดขึ้นจากการขับขี่

ยานพาหนะดวยความเร็วที่เกินกําหนด การขับขี่ยานพาหนะดวยความเร็วเปนการเพ่ิมความเสี่ยงการ

เกิดอุบัติเหตุและความรุนแรงของอุบัติเหตุบนทองถนน เมื่อยานพาหนะมีความเร็วเพ่ิมมากข้ึนจะ

สงผลใหยานพาหนะตองการระยะทางในการเบรคเพ่ือหยุดมากขึ้นดวยเชนกัน ความสามารถในการ

ตัดสินใจกับเหตุการณเฉพาะหนาก็จะลดลง สงผลใหเกิดการตัดสินใจผิดพลาดของผูขับข่ีและอาจทํา

ใหเกิดความเสียหายที่ตามมา 

 จากเหตุผลขางตนจึงทําใหเกิดโครงงานปญหาพิเศษซอฟตแวรสําหรับตรวจจับความเร็ว

ยานพาหนะ โดยซอฟตแวรสามารถวัดความเร็วยานพาหนะไดจากการใชกลองเว็บแคมในการรับ

ขอมูลสตรีมของภาพ ซึ่งจะชวยลดคาใชจายดานฮารดแวรลงได โดยจะใชหลักการของการประมวลผล

ภาพดิจิทัลมาใชในการประมวลผลภาพ ภายในซอฟตแวรจะทําการแยกสตรีมของภาพออกเปนเฟรม

ภาพ เพื่อนําไปใชในการแยกวัตถุที่อยูในภาพ จะทําใหสามารถนําขอมูลไปประมวลผลได โดยวิธีการ

คํานวณความเร็วจะกําหนดจุดอางอิงสองจุดเพ่ือใชสําหรับการคํานวณความเร็วของยานพาหนะ โดย

สองจุดนี้จะมีการกําหนดระยะทางที่แนนอน เมื่อวัตถุเคลื่อนที่เขามายังจุดอางอิงท่ีกําหนด ซอฟตแวร

จะทําการหาคาความตางของเวลาเพื่อคํานวณหาความเร็วตอไปได เมื่อทราบความเร็วของ

ยานพาหนะจะสามารถบันทึกภาพของยานพาหนะที่มีความเร็วเกินกวาที่กฎหมายกําหนด และ

สามารถนําภาพที่บันทึกไปเปนหลักฐานประกอบการลงโทษผูท่ีขับขี่ยานพาหนะเหลานั้น ที่อาจทําให

เกิดอุบัติเหตุบนทองถนนจนเกิดผลกระทบตอชีวิตและทรัพยสินของตนเองหรือผูอ่ืนได 

 

1.2 วัตถุประสงคของงานวิจัย   

    1)  พัฒนาซอฟตแวรเพื่อใชสําหรับตรวจจับความเร็วของยานพาหนะ 

    2)  พัฒนาซอฟตแวรตรวจจับความเร็วยานพาหนะใหมีราคาตนทุนต่ํา 

    3)  พัฒนาซอฟตแวรที่สามารถบันทึกหลักฐานการกระทําความผิดของผูขับข่ียานพาหนะได 

    4)  เพ่ือใหหนวยงานที่เก่ียวของหันมาใชโปรแกรมที่พัฒนาขึ้นในประเทศ

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



2 
 

 

1.3 ขอบเขตของงานวิจัย   

    1)  ซอฟตแวรสามารถตรวจจับความเร็วของยานพาหนะไดเชน รถจักรยาน รถจักรยานยนต รถตู 

รถยนต เปนตน 

    2)  ซอฟตแวรสามารถนับจํานวนรถที่ผานพ้ืนที่ที่กําหนดไวได 

    3)  ซอฟตแวรทํางานบนระบบปฏิบัติการ Windows 

    4)  ซอฟตแวรสามารถบันทึกภาพของยานพาหนะที่มีความเร็วเกินกําหนดได 

    5)  ซอฟตแวรสามารถทํางานไดแบบเรียลไทม 

 

1.4 ประโยชนที่คาดวาจะไดรับ  

    1)  ซอฟตแวรสามารถนําไปใชตรวจจับความเร็วยานพาหนะไดจริงในอนาคต 

    2)  ซอฟตแวรสามารถนับจํานวนยานพาหนะที่ผานไปมาในขณะนั้นได 

    3)  สามารถลดคาใชจายของฮารดแวรและซอฟตแวรสําหรับตรวจจับความเร็วยานพาหนะ 

    4)  ซอฟตแวรสามารถเปนสวนหนึ่งในการลดอุบัติเหตุบนทองถนนได 

    

1.5 เครื่องมือที่ใชทําปญหาพิเศษ 

    1) Hardware  

  • คอมพิวเตอรโนตบุก 

  • กลองเว็บแคม 

    2) Software  

  • ระบบปฏิบัติการ Windows 10 Home Single Language 

  • Visual studio 2015 

  • OpenCV-3.1.0 

  • Qt Creator 5.8.0 
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บทท่ี 2  

ทฤษฎีและงานวิจัยที่เกี่ยวของ  
 

 การตรวจจับความเร็วของยานพาหนะจําเปนตองใชเทคนิคของการประมวลผลภาพและวิดีโอ

เขามาจัดการกับขอมูลที่ถูกนําเขามายังโปรแกรม เพ่ือแยกขอมูลที่สนใจออกจากขอมูลที่ไมตองการ 

ในบทนี้จะกลาวถึงความรูและทฤษฎีที่เกี่ยวของกับการพัฒนาโปรแกรม โดยผูจัดทําไดศึกษารวบรวม

ขอมูลและนําความรูนี้ไปประยุกตใชในการพัฒนาโปรแกรม ซึ่งทฤษฎีที่เก่ียวของที่ไดรวบรวมไว มีดังนี ้

 

2.1 OpenCV 

 2.1.1 ความหมายของ OpenCV 

 OpenCV หรือ Open Source Computer Vision Library[1][2] เปนไลบรารีที่รวบรวมเอา

ความสามารถทางดานการประมวลผลภาพ (Image Processing) และการความสามารถทางดานการ

มองเห็นของคอมพิวเตอร (Computer Vision) พัฒนาโดยทีมงานของบริษัท Intel ตัวไลบรารีนี้ถูก

พัฒนาและขึน้ดวยภาษา C และ C++ ซึ่งสามารถรันไดบนทั้ง Linux , Mac OSX และ Windows 

 OpenCV ถูกออกแบบสําหรับการคํานวณผลที่มีประสิทธิภาพและมีการเนนประยุกตใชงาน

แบบเรียลไทม (Real Time) เปาหมายหนึ่ งของ OpenCV คือการใหบริการโครงสรางสําหรับ

คอมพิวเตอรวิชันที่ใชงานงาย ทําใหผูใชงานสามารถสรางแอปพลิเคชันที่มีความซับซอนไดอยาง

รวดเร็ว ไลบรารี OpenCV บรรจุฟงกชันสําหรับงานดานการประมวลผลภาพประมาณ 500 ฟงกชัน 

ที่ครอบคลุมการใชงานหลายดานเชน การตรวจสอบผลิตภัณฑ การถายภาพทางการแพทย ความ

ปลอดภัย สวนติดตอกับผูใช การปรับเทียบกลอง ระบบสเตอริโอ และหุนยนต ตัวอยางของโคดการ

แสดงผลภาพออกทางจอภาพดวย OpenCV ซึ่งตัวอยางภาษา C++ แสดงดังรูปที่ 2.1 

 

  

 

 

 

 

 

 

 

รูปท่ี 2.1 ตัวอยางการเขียนโคดแสดงผลภาพดวยภาษา C++ 
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 2.1.2 โครงสรางและขอมูลเนื้อหาใน OpenCV 

 OpenCV ประกอบดวย 5 สวนประกอบหลัก และสวนประกอบ 4 สวน แสดงดังรูปที่ 2.2 

 

 

 

 

 

 

 

รูปท่ี 2.2 โครงสรางพื้นฐานของ OpenCV [3] 

 

ความหมายของสวนประกอบ 4 สวน ดังรูปที่ 2.2 สามารถอธิบายไดดงัน้ี 

1) CXCORE เปนสวนของฟงกชันเบื้องตนที่ใชจัดการเก่ียวกับหนวยความจําและ 

การประกาศตัวแปร 

2) CV เปนสวนทีใ่ชในการประมวลผลและการวิเคราะหรูปภาพ 

3) Machine Learning เปนสวนของไลบรารีท่ีรวมคลาสและฟงกชันทางสถิต ิ

(Statistical) การแยกคลาสเปนการแบงกลุมของขอมูล (Clustering) 

4) HighGUI เปนสวนของไลบรารีที่ใชในการดึงขอมูลภาพ การบันทึกภาพ การ

เปลี่ยนขนาดของภาพ 

 

 2.1.3 โครงสรางการเก็บขอมูลในไลบรารี OpenCV 

 การเก็บขอมูลใน OpenCV[4] จะเก็บขอมูลภาพอยูในรูปแบบเมตริกซ โดยภายในเมตริกซจะ

ถูกเก็บแยกเปนจุดๆ ที่เรียกวาพิกเซลลจะขึ้นอยูกับปริภูมิสี (Color Space) และชนิดของตัวแปรที่

เลือกใช ปริภูมิสีหมายถึงวิธีการเขารหัสสีที่ตองการจะแสดง ซึ่งวิธี ท่ีงายท่ีสุดคือใชระดับสีเทา      

(Gray Scale) ที่ใชเฉพาะสีขาวและสีดํามาผสมเพ่ือสรางสีเทาในระดับตางๆ สําหรับการที่จะใชสีนั้นมี

ทางเลือกอยูหลายแบบ แตละแบบจะกําหนดองคประกอบหลักไว 3-4 คา และสามารถสรางสีไดจาก

การผสมองคประกอบหลักเหลานี้ ปริภูมิสีที่นิยมใชกันมากที่สุดคือ RGB โดยมีองคประกอบหลักเปนสี 

3 สีคือ แดง เขียว และน้ําเงิน และบางครั้งก็มีการใสองคประกอบอัลฟา (Alpha) เพ่ิมเขาไปเพ่ือแสดง

ถึงความโปรงใสของพิกเซลล นอกจากนี้ ยังมีปริภูมิสีอ่ืนๆ ที่มีขอดีและขอจํากัดตางๆ กันไป เชน 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



5 
 

 

 RGB เปนปริภูมิที่นิยมใชกันมากที่สุด เพราะเปนระบบสีที่เลียนแบบจากการรับแสงของตา

มนุษย และระบบจอคอมพิวเตอรยังใชระบบนี้ดวยเชนกัน 

 HSV เปนปริภูมิที่แบงสีออกเปนคาเฉดสี (Hue) ความอิ่มตัวของสี (Saturation) และแสง 

(Value/Luminance) ซึ่งเปนวิธีที่ธรรมชาติ และยังสามารถตัดองคประกอบสุดทายออกจาก

การคาํนวณ เพ่ือใหขั้นตอนวิธีที่สรางขึ้นเกิดความผิดพลาดนอยลงเมื่อแสงเปลี่ยนได 

 YCrCb เปนปริภูมิสีทีใ่ชในการเขารหัส JPEG และการถายทอดสัญญาณโทรทัศน 

 CIE L*a*b* เปนปริภูมิสีที่จําลองการกระจายความรูสึกในการมองเห็นของคน ซึ่งเปน

ประโยชนหากตองการวัดความแตกตางระหวางสี 

 

 แตละองคประกอบที่ใชสรางสีจะมีโดเมนท่ีใชไดเปนของตัวเอง ซึ่งจะเปนตัวกําหนดชนิดของ

ตัวแปรท่ีจะนํามาใชเก็บ และชนิดของตัวแปรจะเปนตัวกําหนดวาสามารถควบคุมการใชสีไดในระดับ

ใด  โดยชนิดของตัวแปรที่เล็กที่สุดที่ใชไดคือ Char ที่มีขนาด 8 บิต แตการใช Char ในแตละในปริภูมิ

ที่ใช เชน RGB จะทําใหมีสีไดมากถึง 16.7 ลานสี แตยังสามารถที่จะเพ่ิมความละเอียดของสีไดอีกโดย

การใช float หรือ double  

 

 2.1.4 การสรางตัวแปรชนิด Mat ของไลบรารี OpenCV 

 การสรางตัวแปรชนิด Mat ไลบรารี OpenCV[4] จะมีการสราง คัดลอก หรือเขียนลงไฟลให 

แตบางครั้งจําเปนตองจองหนวยความจําเอง รวมท้ังสั่งพิมพคาภายในเมตริกซออกมาทางหนาจอเพื่อ

ทดสอบความถูกตอง ซึ่งการสั่งพิมพคาสามารถทําไดโดยใชตัวดําเนินการ << ของ Mat โดยตองระวัง

ก็คือคําสั่งนี้สามารถใชไดกับเมตริกซ 2 มิติเทานั้น ตัวแปรชนิด Mat จะทํางานไดดีในการเก็บ

ขอมูลภาพ แตก็เปนคลาสที่ใชเก็บเมตริกซทั่วๆไป ดังนั้นสามารถสรางและจัดการเมตริกซผานคลาสนี้

ได โดยการสรางสามารถทําไดหลายวิธี เชน 

1) การใช Constructor 

    Mat M(2,2, CV_8UC3, Scalar(0,0,255)); 

       cout << “M = ” << endl << ” ” << M << endl << endl; 

 จากโคดของโปรแกรมขางตนเปนการกําหนดขนาดของเมตริกซโดยกําหนดจํานวนแถวและ

คอลัมนหลังจากนั้นจะตองระบุชนิดของตัวแปรที่จะใชเก็บคา และจํานวนองคประกอบแตละหนวย

หรือที่เรียกวาพิกเซลล ซึ่ง OpenCV ไดนิยามชื่อไวสําหรับระบุรายละเอียดเหลานี้ ซึ่งมีรูปแบบเปน 

CV_[จํานวนบิต][มีคาลบหรือไม/ชนิดของตัวแปร]C[จํานวนองคประกอบ] ตัวอยางเชน CV_8UC3 

หมายถึงจะใชตัวแปรแบบไมมีคาลบขนาด 8 บิต (8U = Uchar) และในแตละพิกเซลลประกอบไป

ดวย 3 องคประกอบ (C3) ซึ่งที่นิยามไวจะมีขนาด 8, 16, 32, และ 64 บิต ชนิด U และ S สําหรับคา

จํานวนเต็มแบบไมมีคาลบและมีคาลบ (Unsigned และ Signed) รวมถึง F สําหรับคาแบบมีจุด

ทศนิยม (Floating Point) สําหรับจํานวนองคประกอบสามารถมีไดมากสุด 4 องคประกอบ         
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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และ Scalar เปนเว็กเตอรที่เก็บได 4 คา สําหรับใชกําหนดคาเริ่มตนใหองคประกอบของทุกจุดภายใน

เมตริกซ 

 

2) การใชอารเรยในการกําหนดคาเริ่มตนของ Mat 

int sz[3] = {2,2,2}; 

 Mat L(3,sz, CV_8UC(5), Scalar::all(0)); 

 จากโคดของโปรแกรมขางตน เปนการสรางตัวแปรชนิด Mat เพ่ือเก็บเมตริกซ 3 มิติ แตละ

มิติมี 2 จุด และภายในแตละจุดจะมีท้ังหมด 5 องคประกอบ และกําหนดคาเริ่มตนทั้งหมดเปน 0 

หากเมตริกซมีขนาดมากกวา 2 มิติแลว จะไมสามารถแสดงผลดวยคําสั่ง Cout ได และหากแตละจุดมี

มากกวา 4 องคประกอบแลว จะใช Scalar กําหนดคาเริ่มตนเปน 0 ไดเทานั้น 

 

3) การสราง Mat จาก IplImage * 

 IplImage *img = cvLoadImage(IMAGE_FILE, CV_LOAD_IMAGE_ANYCOLOR); 

Mat mtx(img, true);  

 จากโคดของโปรแกรมขางตนเปนการแปลงและคัดลอก (CopyData=True) ขอมูลใน 

IplImage * มาเก็บไวใน Mat ซึ่งหากตองการคัดลอกเฉพาะรายละเอียด แตใชขอมูลเมตริกซรวมกับ

ตัวแปรแบบ IplImage * สามารถทําไดโดยกําหนด CopyData=False 

 

4) การใชฟงกชัน create() 

Mat M(2,2, CV_8UC3, Scalar(0,0,255)); 

cout << “M = ” << endl << ” ” << M << endl << endl; 

M.create(3,2, CV_8UC(2)); 

cout << “M = ” << endl << ” ” << M << endl << endl; 

 จากโคดของโปรแกรมขางตน ฟงกชัน create() จะไมทําการจองหนวยความจําใหมเพราะ

เมตริกซเกามีขนาดพอดีกับขนาดใหมที่ตองการพอดี ซึ่งการสรางเมตริกซโดยวิธีนี้จะไมสามารถ

กําหนดคาเริ่มตนได 
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2.2 Computer Vision 

คอมพิวเตอรวิทัศน (Computer vision)[5-7] เปนสาขาหนึ่งของวิทยาการคอมพิวเตอร ซึ่งจะ

เก่ียวกับการดึงสารสนเทศจากรูปภาพหรือวีดิทัศน ซึ่งจะใชหลักการทางคณิตศาสตร เชน เรขาคณิต

พีชคณิตเชิงเสน สถิติ เปนตน เพื่อที่จะหาคาที่เหมาะสมที่สุดและการวิเคราะหเชิงฟงกชัน โดย

หลักการทางคณิตศาสตรเหลานี้ใชในการแยกสวนภาพและการจัดกลุมภาพ เพ่ือใหคอมพิวเตอร

สามารถเขาใจองคประกอบของภาพ วัตถุประสงคโดยทั่วไปของคอมพิวเตอรวิทัศนไดแก 

1) การตรวจจับ ตัดแบงขอบเขต ระบุตําแหนงและรูจําวัตถุที่ตองการในภาพ เชน หนาคน 

2) การประเมินผลสําหรับ การตัดเบงขอบเขตวัตถุในภาพหรือการวางเปรียบเทียบ 

3) การวางทาบเทียบมุมมองของภาพหรือวัตถุในภาพ 

4) การติดตามวัตถุในภาพตอเนื่อง 

5) การสรางแบบจําลองสามมิต ิ

6) การประมาณการเคลื่อนไหวของมนุษยในรูปแบบสามมิต ิ

7) การคนหารูปภาพดวยเนื้อหาของภาพในฐานขอมูล 

 

ในปจจุบันไดมีการประยุกตใชคอมพิวเตอรวิทัศนในสาขาตางๆ เชน การแพทย การทหาร ระบบ

ตรวจตราและรักษาความปลอดภัย การตรวจสอบและควบคุมคณุภาพ เปนตน 

 

2.3 สูตรทางฟสิกสที่นํามาประยุกตใช 

 ทฤษฎีทางฟสิกสท่ีนํามาประยุกตใชในการคํานวณความเร็วของยานพาหนะ คือทฤษฎีการ

เคลื่อนที่แนวตรงซึ่งเก่ียวกับอัตราเร็วและความเร็ว [8] 

 อัตราเร็ว คือระยะทางในหนึ่งหนวยเวลา เปนปริมาณสเกลาร โดยคาํนวณไดจากสูตร v =  

  เมื่อ v = อัตราเร็ว หนวยเปน m/s 

       s = ระยาทาง หนวยเปน m 

       t = เวลาหนวยเปน s 

การหาอัตราเร็วแสดงดังรูปที่ 2.3 
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รูปท่ี 2.3 ภาพการหาอัตราเร็ว 

 

2.4 Qt Creator 

 Qt (อานวา คิวต)[9] เปนเครื่องมือในการสรางแอปพลิเคชันที่มี GUI (Graphical User 

Interface) ซึ่งสามารถทํางานบน Desktop PC, Smart Phone และ Embedded System เปนตน 

โดยแอปพลิเคชันที่ถูกพัฒนาดวย Qt Creator นั้นสามารถทํางานไดหลายระบบปฏิบัติการ (OS) ซึ่ง

ทําใหสามารถนําโปรแกรมที่พัฒนาดวย Qt Creator นั้นสามารถทํางานบน OS อื่นไดโดยไมตองแกไข

โปรแกรม  

การเขียน GUI ดวย Qt Creator สามารถเลือกใช API, Library ไดมากหมาย เชน .NET เปน

ตน นอกจากนั้นยังสามารถพัฒนารวมกับภาษาไดหลากหลาย เชน C++, Java, Python, Perl, 

Pascal และ PHP เปนตน โดย Qt Creator นั้นจะแยกสวนที่ เปนสวนติดตอผู ใชและสวนการ

ประมวลผลไวอยางชัดเจนทําใหสามารถพัฒนาแอปพลิเคชันไดสะดวก และเม่ือทําการพัฒนาเสร็จสิ้น

การสงออกแอปพลิเคชันที่พัฒนาใหสามารถทํางานบนเครื่องอ่ืนสามารถทําไดสะดวกโดยใช Execute 

File ของแอปพลิเคชัน และ DLL (Dynamic-Link Library) ที่แอปพลิเคชันตองการไปติดตั้งลงบน

เครื่องท่ีตองการ ซึ่งจะทําใหติดตั้งไดงายและใชทรัพยากรของเครื่องนอยลง 

DLL (Dynamic-Link Library) เปน โปรแกรมไฟลขนาดเล็กใชได ในระบบปฏิบัติการ 

Windows ซึ่งจะถูกเรียกใชงานโดยโปรแกรมหลักก็ตอเมื่อโปรแกรมหลักจําเปนตองทํางานบางงาน 

ซึ่ง DLL ไฟลแตละไฟลก็จะมีความสามารถแตกตางกัน เมื่อโปรแกรมหลักตองการทํางานดวย

ความสามารถไหนก็จะโหลด DLL ไฟลที่จําเปนข้ึนมาทํางาน ณ ขณะนั้น จากลักษณะการทํางาน

ดังกลาวจึงทําใหประหยัดหนวยความจําได และสามารถติดตั้งโปรแกรมที่พัฒนาไดงายข้ึน และหาก 

DLL ไฟลมีปญหาจะสามารถแกไขปญหาท่ี DLL ไฟลไดเลย หลังจากการแกไขก็จะสงผลไปยัง

โปรแกรมหลักทุกโปรแกรมที่เรียกใช DLL ไฟลนี้ไมจําเปนตองเชื่อมโปรแกรมหลักเขากับ DLL ไฟล

ใหม 
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2.5 Webcam 

 เว็บแคม (Webcam) หรือ เว็บแคเมรา (Web Camera)[10] เปนกลองที่สงสัญญาณภาพ

ผานทางคอมพิวเตอรสําหรับใชงานผานทางเวิลดไวดเว็บ หรือทางซอฟตแวรอ่ืน 

 ชนิดของกลองเว็บแคมจะแบงออกได 2 ชนิด คือ 

1) กลองเว็บแคมแบบมีสาย 

 กลองเว็บแคมแบบมีสายจะมีความยุงยากในเรื่องของการตอพวงเขากับ

เครื่องคอมพิวเตอร แตจะมีราคาถูกกวาแบบไรสายมาก 

 ขอเสีย ของกลองเว็บแคมแบบมีสายคือ ทําใหไมสามารถวางตัวกลองได

ไกลจากเครื่องคอมพิวเตอร ทําใหกลองไมสามารถจับภาพเคลื่อนไหวใน

ระยะไกลๆได 

2) กลองเว็บแคมแบบไรสาย 

 กลองเว็บแคมแบบไรสายจะมีราคาแพงเมื่อเทียบกับกลองเว็บแคมแบบมี

สาย เนื่องจากตัวกลองตองใชเทคโนโลยีแบบไรสายที่เรียกวา Wireless Wifi 

หรือ IEEE 802.11 ที่มีตนทุนสูง 

 จุดเดนของกลองเว็บแคมแบบไรสายคือ สามารถนําไปติดตัง้ที่จุดใดก็ไดโดย

ไมตองคํานึงถึงระยะหางระหวางตัวกลองกับเครื่องคอมพิวเตอร 

 

 สวนประกอบของกลองเว็บแคมประกอบดวยสวนตางๆที่สําคัญดังนี ้

1) เลนสกลอง 

 ทําหนาที่ในการจับภาพเคลื่อนไหวตางๆที่เคลื่อนไหวผานไปมาอยูหนา

กลองหรืออยูในตําแหนงท่ีเลนสกลองสามารถเห็นภาพได 

2) ตัวปรับระยะโฟกัส 

 ทําหนาที่ในการปรับโฟกัสของภาพเพ่ือใหภาพมีความชัดเจนมากขึ้น 

3) ฐานรองกลอง 

 ทําหนาที่สําหรับเปนที่ตั้งของตัวกลองซึ่งชวยใหสามารถวางกลองบน

หนาจอคอมพิวเตอรไดสะดวก 
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 ประโยชนของกลองเว็บแคม 

1) ทําใหการติดตอสื่อสารผานอินเทอรเน็ต สามารถพูดคุยแบบเห็นหนาและการ

เคลื่อนไหวตางๆของคูสนทนา 

2) ประหยัดเวลาไมตองเดินทางไปประชุมตามที่ตางๆ เนื่องจากสามารถนําเอา

กลองเว็บแคมมาดัดแปลงเปนกลอง Video Conference เพื่อใช ในการ

ติดตอสื่อสารแบบเห็นหนากันได 

3) ชวยใหปลอดภัยจากการเดินทางไปประชุมหรือไปสัมมนาตามสถานที่ตางๆที่อยู

หางไกลได 

4) สามารถนําไปประยุกตใชเปนอุปกรณรักษาความปลอดภัยคลายกับกลองวงจร

ปด โดยสามารถใชโปรแกรมท่ีติดมากับกลองเว็บแคมเชื่อมตอเขากับกลองเว็บ

แคมเพ่ือคอยตรวจจับภาพเคลื่อนไหว  

5) ชวยใหสามารถเผยแพรภาพเหตุการณตางๆ จากกลองเว็บแคมผานทางเว็บไซต

เพ่ือใหคนทั่วโลกสามารถเขามารับชมได 

 

2.6 งานวิจัยที่เกี่ยวของ 

 Chomtip Pornpanomchai and Kaweepap Kongkittisan ไดนําเสนองานวิจัยเรื่อง 

Vehicle Speed Detection System[11] 

งานวิจัยนี้จะพัฒนาระบบตรวจจับความเร็วรถยนตโดยใชเทคนิคของ Image Processing 

ผลงานโดยรวมมีการพัฒนาซอฟตแวรของระบบที่ตองใชวิดีโอ ซึ่งมีองคประกอบตางๆ ดังตอไปนี้ 

Moving Vehicle จุดอางอิงจุดเริ่มตนและสิ้นสุดจุดอางอิง ระบบถูกออกแบบมาเพ่ือตรวจหาตําแหนง

ของรถยนตที่เคลื่อนที่ และตําแหนงของจุดที่จะใชอางอิง และคํานวณความเร็วของแตละเฟรมภาพนิ่ง

จากตําแหนงที่ตรวจพบ การตรวจจับความเร็วของรถยนตจากระบบ Video Frame ที่ประกอบดวย 

6 องคประกอบหลักดังนี้ 

1) Image Acquisition การรวมภาพ สําหรับเก็บภาพเดี่ยวที่ไดจากวิดีโอแลวเก็บไวใน 

Temporary Storage 

2) Image Enhancement เปนการปรับปรุงลักษณะบางอยางของภาพใหมีความ

ชัดเจน และเพ่ิมประสิทธิภาพของภาพ 

3) Image Segmentation การตรวจจับตําแหนงของรถยนตโดยใชความแตกตางของ

ภาพ 

4) Image Analysis เปนการวิเคราะหตําแหนงของจุดท่ีใชอางอิงเปนจุดเริ่มตนและ

จุดสิ้นสุด โดยใชเทคนิค Threshold 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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5) Speed Detection เอาไวใชในการคํานวณความเร็วของรถยนตในเฟรมภาพเดียว 

เปนการตรวจจับตําแหนงรถยนต และการอางอิงตําแหนงของรถยนต 

6) Report เปนการถายทอดขอมูลใหกับผูใช ใหอานเขาใจไดงาย 

การทําการทดลองเพ่ือประเมินคุณสมบัติมี 3 ประการดังนี ้

1) Usability (การใชงาน) คือ ซอฟตแวรสามารถตรวจจับยานพาหนะไดทุกเฟรมภาพ 

และสามารถนํามาคํานวณความเร็วได 

2) Performance (ประสิทธิภาพ) คือ การทดสอบประสิทธิภาพเวลาในการดําเนินการ

ของระบบในขณะที่ดําเนินการวิเคราะหภายใตสถานการณที่แตกตางกันเก่ียวกับ

ปจจัยที่แตกตางกัน 

3) Effectiveness (ประสิทธิผล) คือ การทดสอบประสิทธิภาพของความถูกตองของ

ผลลัพธ จากการทดสอบจากสถานการณที่แตกตางกันในการวิเคราะหขอมูล พบวา

ปจจัยที่มีผลตอความถูกตองของระบบ เชน ความละเอียดของขนาดภาพ

ยานพาหนะ กรอบรูป การเคลื่อนไหวของยานพาหนะ และ ความซับซอนของพื้น

หลัง 

ผลการทดลอง สามารถสรุปไดวาระบบทํางานดวยประสิทธิภาพสูงสุดที่ความละเอียด      

320 x 240 จะใชเวลาประมาณ 70 วินาทีในการตรวจสอบรถยนตที่ เคลื่อนไหวอยูในวิดีโอ            

ดังแสดงรูปที่ 2.4 

 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 2.4 แผนภูมิโครงสรางของระบบตรวจจับความเร็ว 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 
 

บทท่ี 3  

วิธีการดําเนินงาน                            
 

       วิธีการดําเนินงานของแอปพลิเคชันสําหรับการตรวจจับความเร็วยานพาหนะ มีขั้นตอน

การทํางานดังตอไปนี้ 

 

3.1  โครงสรางโดยรวมของระบบ 

 หลักการทํางานโดยรวมของระบบตรวจจับความเร็วยานพาหนะ ผานเดสกท็อปแอปพลิเคชัน

มีโครงสรางของระบบแสดงดังรูปที่ 3.1 

 
 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.1 โครงสรางโดยรวมของระบบ 
 

จากรูปที่ 3.1 จะแสดงสถาปตยกรรมของระบบ โดยสามารถอธิบายรายละเอียดการทํางานไดดังนี้ 

1. ผูใชงานทําการเปดแอปพลิเคชัน 

2. ผูใชงานทําการเชื่อมตอกลองเว็บแคม และทําการตั้งคาแอปพลิเคชัน จากนั้นตัวแอปพลิเคชัน

จะทําการประมวลผลภาพเพ่ือคํานวณความเร็ว และนับจํานวนยานพาหนะที่ผานเสนอางอิง

ที่กําหนดไว และหากมียานพาหนะที่มีความเร็วเกินกวาที่กําหนดไว แอปพลิเคชันจะทําการ

บันทึกภาพของยานพาหนะคันนั้นแลวเก็บไวที่ File Storage 

3. File Storage เปนที่เก็บขอมูลภาพของยานพาหนะที่มีความเร็วเกินกําหนด ผูใชงานสามารถ

เขาไปดูไดผานเดสกท็อป 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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3.2  การออกแบบระบบ 

3.2.1 แผนภาพแสดงความสามารถของระบบงาน (Use Case Diagram) 

ความสามารถของซอฟตแวรสําหรับตรวจจับความเร็วยานพาหนะสามารถแสดงรายละเอียด

ไดดังรูปที่ 3.2 

 

 

 

รูปท่ี 3.2 แผนภาพความสามารถของซอฟตแวรสําหรับตรวจจับความเร็วยานพาหนะ 
 

 

 

 

 

 

 

 

Software for Vehicle Speed Detection 

Set Speed Limit of Vehicle 

User Process and Analyze Vehicle  

Speed and Number of Vehicle 

 

Connect a Webcam 

Show Vehicle Speed and 

Number of Vehicle 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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3.2.2 คําอธิบายยูสเคส 

  แผนภาพยูสเคสสามารถเขียนคําอธิบายไดดงัตารางที่ 3.1 ถึงตารางท่ี 3.4 

1) Connect a Webcam 

ตารางที่ 3.1 คําอธิบายของผูใชงานแอปพลิเคชันในการเชื่อมตอกลองเวบ็แคม 

Use Case Name : Connect a Webcam 

Actors : User 

Brief Description : สําหรับใหผูใชงานไดทําการเชื่อมตอกับอุปกรณเว็บแคม เพ่ือรับภาพมา

ทําการประมวลผลวัดความเร็วและนับจํานวนยานพาหนะ 

Pre – Condition : เชื่อมตอกลองเว็บแคม 

Post – Condition : แสดงภาพวิดโีอสตรีมที่ไดจากกลองเว็บแคม 

Flow of Events : User System 

 เลือกเมนูเชื่อมตอกลองเว็บแคม แสดงภาพจากเว็บแคม 

Exceptions :  

 

2) Set Speed Limit of Vehicle 

ตารางที่ 3.2 คําอธิบายของผูใชแอปพลิเคชันในการตั้งคาจํากัดความเร็วของยานพาหนะ 

Use Case Name : Set Speed Limit of Vehicle 

Actors : User 

Brief Description : สําหรับใหผูใชงานตั้งคาความเร็วท่ีเกินกําหนดบนแอปพลิเคชัน 

Pre – Condition : ใสคาความเร็วท่ีเกินกําหนดใหกับแอปพลิเคชัน 

Post – Condition : ระบบจะกําหนดคาความเร็วจํากัดของยานพาหนะ 

Flow of Events : User System 

 ใสคาความเร็วท่ีเกินกําหนดของ

ยานพาหนะ 

ระบบจะกําหนดคาความเร็ว

จํากัดของยานพาหนะ 

Exceptions :  

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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3) Process and Analyze Vehicle Speed and Number of Vehicle  

ตารางที่ 3.3 คําอธิบายของผูใชแอปพลิเคชันในการคํานวณความเร็วของยานพาหนะ 

Use Case Name : Process and Analyze Vehicle Speed and Number of Vehicle 

Actors : User 

Brief Description : สําหรับตรวจจับความเร็วยานพาหนะและนับจํานวนยานพาหนะ 

Pre – Condition : เลือกเมนูเริ่มตนการประมวลผล 

Post – Condition : แสดงความเร็วของยานพาหนะหรือจํานวนพาหนะ 

Flow of Events : User System 

 เลือกเมนูเริ่มตนการประมวลผล 

 

1. เก็บภาพยานพาหนะท่ี

ความเร็วเกินกําหนด 

2. นับจํานวนของยานพาหนะ 

Exceptions :  

 

4) Show Vehicle Speed and Number of Vehicle  

ตารางที่ 3.4 คําอธิบายของผูใชแอปพลิเคชันในการดูผลคํานวณความเร็วของยานพาหนะ 

Use Case Name : Show Vehicle Speed and Number of Vehicle 

Actors : User 

Brief Description : สําหรับขอดูผลของการตรวจจับความเร็วยานพาหนะและนับยานพาหนะ 

Pre – Condition : เลือกเมนูสําหรับดูภาพยืนยัน 

Post – Condition : แสดงภาพของยานพาหนะที่มีความเร็วเกินกําหนด 

Flow of Events : User System 

 เลือกเมนูสําหรับดูภาพยืนยัน 1. แสดงภาพของยานพาหนะที่

มีความเร็วเกินกําหนด 

2. แสดงผลการนับ 

Exceptions :  

 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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3.2.3 การออกแบบกระบวนการทํางานของซอฟตแวร 
1) กระบวนการทํางานของการตรวจจับความเร็วของยานพาหนะ ดังรูปที่ 3.3 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 3.3 กระบวนการทํางานของซอฟตแวรในการตรวจจับความเร็วยานพาหนะ 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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2) กระบวนการทํางานของการนับจํานวนยานพาหนะ ดังรูปที่ 3.4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 3.4 กระบวนการทํางานของซอฟตแวรในการนับจํานวนยานพาหนะ 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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3.2.4 แผนภาพแสดงลําดับการทํางาน (Sequence Diagram) 
1) ลําดับการทํางานของซอฟตแวรสําหรับตรวจจับความเร็วยานพาหนะภาพรวม 

แสดงลําดับการทํางานดังรูปที่ 3.5 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปท่ี 3.5 Sequence Diagram ของซอฟตแวรการตรวจจับความเร็วยานพาหนะ 

 

 

 

 

 

 

 

 

 

 

 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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2) ลําดับการทํางานของสวนของข้ันตอนการประมวลผลภาพ แสดงดังรูปที่ 3.6 
 
 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.6 Sequence Diagram สวนของข้ันตอนการประมวลผลภาพ 

 

3) ลําดับการทํางานของสวนการนับจํานวนยานพาหนะ แสดงดงัรูปที่ 3.7 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.7 Sequence Diagram ของสวนการนับจํานวนยานพาหนะ 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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3.3 แผนภาพแสดงกิจกรรมของงาน (Activities Diagram) 
3.3.1 การแสดงภาพจากกลองเว็บแคมที่ตัวแอปพลิเคชัน 

ขั้นตอนการการแสดงภาพจากกลองเว็บแคมที่ตัวแอปพลิเคชัน แสดงดังรูปที่ 3.8 
 

 
 

รูปท่ี 3.8  Activity Diagram การแสดงภาพจากกลองเว็บแคมที่ตัวแอปพลิเคชัน 
 

 
 
 
 

User Application Webcam 

   

ผูใชงานทําการ

เชื่อมตอกลอง 

เว็บแคม 

ทําการสงคํารองขอภาพ

จากกลองเว็บแคมมา

แสดงที่ตัวแอปพลิเคชัน 

แสดงภาพที่รับมาจาก

กลองเว็บแคม 

สงสัญญานภาพกลับไป

ที่ตัวแอปพลิเคชัน 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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3.3.2 การเรียกดูภาพยานพาหนะที่มีความเร็วเกินกําหนด 
ขั้นตอนการเรียกดูภาพยานพาหนะที่มีความเร็วเกินกําหนดแสดงดังรูปที่ 3.9 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
รูปท่ี 3.9  Activity Diagram การแสดงภาพยานพาหนะที่มีความเร็วเกินกวาที่ผูใชกําหนด 
 
 
 
 
 
 

User Application 

  

ผูใชเรียกดูภาพ

ยานพาหนะที่มี

ความเร็วเกินกําหนด 

ไปยังโฟลเดอรที่เก็บภาพ

ยานพาหนะที่มีความเร็ว

เกินกําหนด 

แสดงภาพของ

ยานพาหนะที่ความเร็ว

เกินกวาที่ผูใชกําหนด 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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3.3.3 การตรวจจับความเร็วของยานพาหนะที่ความเร็วเกินกวาที่กําหนดไว  
ขั้นตอนการตรวจจับความเร็วยานพาหนะทีมีความเร็วเกินกวาท่ีกําหนดไว แสดง

รายละเอียดไดดังรูปที่ 3.10 
 

 
รูปท่ี 3.10 Activity Diagram การตรวจจับยานพาหนะที่มีความเร็วเกินกวาที่กําหนดไว 

 
 

 

 

 

 

 

User Application File Storage  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

กําหนดความเร็วสูงสุด

ของยานพาหนะ 

คํานวณความเร็วของ

ยานพาหนะแตละคัน 

บันทึกขอมูล 

 

[ความเร็วเกินกําหนด] 

[ความเร็ว 

ไมเกินกําหนด] 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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3.4 การออกแบบหนาจอของผูใชงาน (User Interface) 
การออกแบบหนาจอของผูใชงาน เปนการนําเครื่องมือตางๆจากกลองเครื่องมือ (Toolbox) 

มาวางประกอบกันในพ้ืนท่ีการออกแบบโปรแกรมตามลักษณะการทํางานของโปรแกรมท่ีตองการ 
สําหรับการออกแบบหนาจอของซอฟตแวรสําหรับตรวจจับความเร็วยานพาหนะ มีรายละเอียดดังนี ้

 
1) หนาตางเริ่มตนของโปรแกรม 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.11 หนาจอเริ่มตนของโปรแกรม 
 

จากรูปท่ี 3.11  เปนหนาตางเริ่มตนของโปรแกรม โดยโปรแกรมจะแบงออกเปน 2 สวนการ

ทํางานคือ สวนของจอแสดงผล และสวนควบคุมการทํางาน สําหรับสวนของจอแสดงผลเปนสวนของ

การแสดงภาพที่รับมาจากกลองเว็บแคม หรือภาพที่ผานการประมวลผลภาพแลว สําหรับสวนของการ

ควบคุมการทํางานของโปรแกรมจะประกอบไปดวยสวนตางๆ แสดงดังรูปที่ 3.12 

 

2) หนาจอควบคมุการทํางาน 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.12 สวนควบคุมการทํางานของโปรแกรม 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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จากรูปที่ 3.12 เปนสวนควบคุมการทํางานของโปรแกรมโดยจะประกอบไปดวย สวนแสดง

วันที่และเวลาที่ใชงานของโปรแกรม ปุมสําหรับเชื่อมตอและยกเลิกการเชื่อมตอกลองเว็บแคม สวน

แสดงความละเอียดของภาพ สวนแสดงสถานะการเชื่อมตอกลองเว็บแคม สวนของการกําหนด

ความเร็วจํากัด สวนแสดงคาความเร็วของยานพาหนะ สวนของการแสดงผลจํานวนยานพาหนะ และ

ปุมสําหรับเรียกดูภาพยานพาหนะที่มีความเร็วเกินกําหนด 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 
 

บทท่ี 4  

ผลการวิจัยและการอภิปรายผล  
 

ในการทดสอบการทํางานของแอปพลิเคชันบนระบบปฏิบัติการวินโดวสสําหรับตรวจจับ

ความเร็วยานพาหนะ จะทําการเชื่อมตอกลองเว็บแคมเพ่ือสตรีมภาพจากกลอง มาใชในการคํานวณ

ความเร็วของยานพาหนะ มีรายละเอียดดังนี้ 

 

4.1 การใชงานโปรแกรม 

 เมื่อเปดโปรแกรมจะเขาสูหนาตางเริ่มตน แสดงดังรูปที่ 4.1 
 

 
 

รูปท่ี 4.1 หนาจอเริ่มตนของโปรแกรม 

 

จากรูปที่ 4.1 หากผูใชตองการตรวจจับความเร็วยานพาหนะ ใหทําการเชื่อมตอกับกลองเว็บ

แคมโดยกดปุม Start เพ่ือรับภาพวิดีโอจากกลองเว็บแคม หรือกดปุม Browse เพ่ือนําเขาขอมูลวิดีโอ

ไฟลที่ตองการประมวลผล ดังรูปที่ 4.2 

 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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รูปท่ี 4.2 หนาจอของโปรแกรมเมื่อกดปุม Browse 

 

จากรูปที่ 4.2 เม่ือเชื่อมตอกับกลองเว็บแคมหรือเลือกวิดีโอไฟลสําหรับประมวลผลแลว 

ผูใชงานจะตองตั้งคาความเร็วจํากัดตามที่ผูใชตองการ ดังรูปที่ 4.3 

 

 

รูปท่ี 4.3 หนาจอตอนตั้งคาความเร็วจํากัด 

 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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จากรูปที่ 4.3 หลังจากตั้งคาความเร็วจํากัดแลวกดปุมเริ่มการใชงาน แอปพลิเคชันจะทําการ

สรางเสนอางอิงสําหรับนับจํานวนยานพาหนะ เมื่อมีวัตถุ เคลื่อนที่ผานเสนอางอิงที่ กําหนด          

แอปพลิเคชันจะทําการเพ่ิมคาจํานวนวัตถุที่นับได และมีการสรางกรอบพื้นท่ีสําหรับวัดความเร็ว เมื่อ

วัตถุเขามาในกรอบจะทําการบันทึกเวลาที่วัตถุปรากฏอยูในกรอบจนกระทั่งวัตถุเคลื่อนที่ออกจาก

กรอบ เพ่ือนําไปใชในการคํานวณหาความเร็วของวัตถุ ดังรูปที่ 4.4 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 4.4 หนาจอขณะใชงานแอปพลิเคชัน 

 

จากรูปที่ 4.4 แอปพลิเคชันทําการประมวลผลหาคาความเร็วของวัตถุที่วิ่งผานพ้ืนท่ีที่กําหนด 

หากมีวัตถุใดเคลื่อนที่ผานแลวมีคาความเร็วเกินกวาที่กําหนดไว แอปพลิเคชันจะทําการถายภาพวัตถุ

ที่มีความเร็วเกินกําหนด และบันทึกภาพของวัตถุไวที่โฟลเดอรที่แอปพลิเคชันกําหนดไว ดังภาพที่ 4.5 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 4.5 โฟลเดอรที่เก็บภาพของยานพาหนะที่มีความเร็วเกินกําหนด 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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 จากรูปที่ 4.5 แอปพลิเคชันมีการเก็บภาพของวัตถุที่มีความเร็วเกินกําหนด ภายในภาพจะ

ประกอบไปดวยคาความเร็วของยานพาหนะนั้นๆ ขณะวิ่งออกจากกรอบที่กําหนดไว ดังรูปที่ 4.6 

 

รูปท่ี 4.6 การจับภาพของยานพาหนะที่มีความเร็วเกินกําหนด 

 

4.2 ผลการทดสอบ 

 ผูพัฒนาไดทําการทดสอบซอฟตแวรสําหรับตรวจจับความเร็วดังนี ้

 4.2.1 การทดลองความแตกตางของมุมที่ใชในการติดตั้งกลองเว็บแคม 

 1) วัตถุประสงค 

เปนการทดลองเพ่ือทดสอบวามุมที่ใชในการติดตั้งกลองเว็บแคมจะสงผลกระทบตอ

การตรวจวัดความเร็วยานพาหนะหรือไม 

 2) วิธีการทดลอง 

วิธีการทดลองจะทําการนํากลองเว็บแคมมาติดตั้งไวดวยคามุมที่ตางกัน ในการ

ทดลองนี้จะทดลองมุม 60, 65 และ 70 องศา และทําการบันทึกคาความเร็วของ

ยานพาหนะท่ีตรวจวัดได โดยกําหนดใหยานพาหนะที่ใชในการทดสอบเคลื่อนที่ดวย

ความเร็ว 30 km/h. โดยแตละมุมจะทําการทดสอบ 3 รอบ สถานที่ในการทดลองคือ

บริเวณสะพานลอยหนาอาคารเรียนรวม 12 ชั้น คณะวิศวกรรมศาสตร สจล.  

 

 

 

 

 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



29 
 

 

 การทดสอบมุมกลอง 60 องศา รอบที่ 1 แสดงดังรูปที่ 4.7 

 
 

รูปท่ี 4.7 ภาพผลการทดสอบมุมกลอง 60 องศา รอบที่ 1 

 

 การทดสอบมุมกลอง 60 องศา รอบที่ 2 แสดงดังรูปที่ 4.8 

 
 

รูปท่ี 4.8 ภาพผลการทดสอบมุมกลอง 60 องศา รอบที่ 2 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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 การทดสอบมุมกลอง 60 องศา รอบที่ 3 แสดงดังรูปที่ 4.9 

 
 

รูปท่ี 4.9 ภาพผลการทดสอบมุมกลอง 60 องศา รอบที่ 3 

 

 การทดสอบมุมกลอง 65 องศา รอบที่ 1 แสดงดังรูปที่ 4.10 

 
 

รูปท่ี 4.10 ภาพผลการทดสอบมุมกลอง 65 องศา รอบที่ 1 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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 การทดสอบมุมกลอง 65 องศา รอบที่ 2 แสดงดังรูปที่ 4.11 

 
 

รูปท่ี 4.11 ภาพผลการทดสอบมุมกลอง 65 องศา รอบที่ 2 

 

 การทดสอบมุมกลอง 65 องศา รอบที่ 3 แสดงดังรูปที่ 4.12 

 
 

รูปท่ี 4.12 ภาพผลการทดสอบมุมกลอง 65 องศา รอบที่ 3 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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 การทดสอบมุมกลอง 70 องศา รอบที่ 1 แสดงดังรูปที่ 4.13 

 
 

รูปท่ี 4.13 ภาพผลการทดสอบมุมกลอง 70 องศา รอบที่ 1 

 

 การทดสอบมุมกลอง 70 องศา รอบที่ 2 แสดงดังรูปที่ 4.14 

 
 

รูปท่ี 4.14 ภาพผลการทดสอบมุมกลอง 70 องศา รอบที่ 2 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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 การทดสอบมุมกลอง 70 องศา รอบที่ 3 แสดงดังรูปที่ 4.15 

 
 

รูปท่ี 4.15 ภาพผลการทดสอบมุมกลอง 70 องศา รอบที่ 3 

 

จากการทดลองความแตกตางของมุมที่ใชในการติดตั้งกลองเว็บแคม ทําใหทราบผลการ

ทดลองแสดงดังตารางท่ี 4.1 

ตารางที่ 4.1 ผลการทดสอบความแตกตางของมุมที่ใชในการติดตั้งกลองเว็บแคม 

มุมกลอง 

ความเร็วของยานพาหนะในมุมตางๆ 

รอบท่ี 1 

(km/hr) 

รอบท่ี 2 

(km/hr) 

รอบท่ี 3 

(km/hr.) 

เฉลี่ย 

(km/hr) 

60 ˚ 30.94 31.05 29.76 30.58 

65 ˚ 29.45 27.76 28.38 28.53 

70 ˚ 31.13 29.82 30.72 30.55 

 

จากตารางที่ 4.1 ทําใหทราบวาติดตั้งกลองมุมใด สามารถวัดความเร็วยานพาหนะไดแมนยํา

ที่สุด โดยจากการทดสอบจะกําหนดความเร็วยานพาหนะไวที่ 30 km/hr จากการทดลองพบวามุม 

70 องศามีความคลาดเคลื่อนของความเร็วนอยที่สุด ซึ่งสามารถวัดไดคาความเร็วเฉลี่ย 30.55 km/hr 

หรืออยูที่ ± 2 km/hr และปญหาตอการคํานวณของซอฟตแวรคือการที่วัตถุอยูใกลกันมากเกินไปจะ

ทําใหซอฟตแวรมองวัตถุเปนกอนเดยีวกัน จึงทําใหไดความเร็วของยานพาหนะคันเดียว 

 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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4.2.2 การทดลองความสามารถของซอฟตแวรในการตรวจจับยานพาหนะ 

 1) วัตถุประสงค 

เปนการทดลองเพ่ือทดสอบวาซอฟตแวรสามารถตรวจจับยานพาหนะประเภทไหน

ไดบาง 

2) วิธีการทดลอง 

วิธีทําการทดลองจะทําการนํากลองเว็บแคมซึ่งเชื่อมตอกับซอฟตแวรสําหรับ

ตรวจจับความเร็วยานพาหนะมาติดตั้ง สถานที่ที่ใชในการทดลองคือบริเวณสะพาน

มอเตอรเวย เขตลาดกระบังกรุงเทพมหานคร และสะพานลอยหนาอาคารเรียนรวม 12 

ชั้น คณะวิศวกรรมศาสตร สจล.  

 

จากการทดลองความสามารถของซอฟตแวรในการตรวจจับยานพาหนะ ทําใหทราบผลการ

ทดลองแสดงดังตารางท่ี 4.2 (โดย √ หมายถึงสามารถตรวจจับได และ x ไมสามารถตรวจจับได) 

ตารางที่ 4.2 ผลการทดสอบของซอฟตแวรในการตรวจจับยานพาหนะประเภทตางๆ 
 
 

 

 

 

 

 

 

 

 

จากตารางที่ 4.2  ทําใหทราบวาซอฟตแวรสามารถตรวจจับยานพาหนะไดหลากหลาย

ประเภทเชน รถจักรยาน รถจักรยานยนต รถยนต รถตู รถบรรทุก รถพวง เปนตน จากประเภท

ยานพาหนะในตารางที่ ทําการทดสอบ กรณีรถพวงสามารถคํานวณความเร็วไดเหมือนกัน แต

ซอฟตแวรจะมองรถพวงเปนวัตถุ 2 กอน จึงทําใหไดคาความเร็วมา 2 คา 

 

 

 

 

 

 

ประเภท

ยานพาหนะ 
ตรวจจับได ตรวจจับไมได 

จักรยาน √  

จักรยานยนต √  

รถยนต √  

รถตู √  

รถบรรทุก √  

รถพวง √  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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4.2.3 การทดลองความหนวงเวลาการแสดงผลของซอฟตแวร 

1) วัตถุประสงค 

เปนการทดลองเพื่อหาความหนวงเวลาของซอฟตแวรเมื่อเทียบกับเวลาจริงที่

ยานพาหนะเคลื่อนที่เขามายังพ้ืนที่ตรวจวัดความเร็ว 

2) วิธีการทดลอง 

วิธีการทดลองคือ ทําการจับเวลาเมื่อยานพาหนะเคลื่อนท่ีเขามายังพ้ืนที่ตรวจวัด

ความเร็วและทําการจับเวลาเม่ือกลองเว็บแคมแสดงผลภาพของยานพาหนะขณะเขา

มายังพ้ืนที่ตรวจวัดความเร็ว จากนั้นนําคาของเวลาทั้งสองมาหาคาความแตกตางเพ่ือหา

คาความหนวงเวลา สถานท่ีในการทดลองคือบริเวณสะพานลอยหนาอาคารเรียนรวม 12 

ชั้น คณะวิศวกรรมศาสตร สจล. 

 

จากการทดลองความหนวงเวลาการแสดงผลของซอฟตแวร ทําใหทราบผลการทดลองแสดง

ดังตารางที่ 4.3 

ตารางที่ 4.3 ผลการทดสอบความหนวงเวลาของซอฟตแวรในการตรวจวัดความเร็ว 

รอบการทดลอง 
เวลาจริง 

(s.) 

เวลาแสดงผล 

(s.) 

ความหนวงเวลา 

(s.) 

รอบท่ี 1 00.67 02.33 1.66 

รอบท่ี 2 00.79 01.60 0.81 

รอบท่ี 3 00.71 01.50 0.79 

เฉลี่ย 1.0866 
 

จากตารางที่ 4.3 ทําใหทราบคาความหนวงเวลาเฉลี่ยของซอฟตแวร ซึ่งเฉลี่ยประมาณ

1.0866 วินาที เปนคาความตางของเวลาระหวางการแสดงผลของซอฟตแวรกับเวลาจริงท่ียานพาหนะ

เคลื่อนที่ 
 

4.2.4 การทดลองความสามารถซอฟตแวรในการตรวจจับวัตถุในเวลากลางคืน 

1) วัตถุประสงค  

เปนการทดลองเพ่ือทดสอบวาซอฟตแวรสามารถตรวจจับยานพาหนะตอนกลางคืน

ไดหรือไม 

 2) วิธีการทดลอง 

วิธีการทดลองคือ นํากลองเว็บแคมไปติดตั้งเพ่ือรับภาพสตรีม และนํามาประมวลผล

ที่ตัวแอปพลิเคชัน เพื่อตรวจหาวัตถุ สถานที่ที่ใชในการทดลองคือ บริเวณสะพาน

มอเตอรเวย และสะพานลอยหนาอาคารเรียนรวม 12 ชั้น คณะวิศวกรรมศาสตร สจล. 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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จากการทดลองที่ 4.2.4 แสดงผลดังรูปที่ 4.16 และรูปที่ 4.17 

 บริเวณสะพานมอเตอรเวย 

 

 

 

 

 

 

 

 

 

รูปท่ี 4.16 ภาพการตรวจจับยานพาหนะบริเวณสะพานมอเตอรเวย 

 

 สะพานลอยหนาอาคารเรียนรวม 12 ชั้น คณะวิศวกรรมศาสตร สจล. 

 
 
 
 
 
 
 
 
 
 
 
 

 
รูปท่ี 4.17 ภาพการตรวจจับยานพาหนะบริเวณสะพานลอยหนาอาคารเรียนรวม 12 ชั้น 

คณะวิศวกรรมศาสตร 
 

จากรูปที่ 4.16 และรูปที่ 4.17 จะเห็นวาซอฟตแวรสามารถตรวจจับยานพาหนะในเวลา

กลางคืนได แตในบางวัตถุไมสามารถตรวจจับไดทั้งกอน ขึ้นอยูกับแสงสวางของสถานที่นั้นๆ ถาแสง

นอยซอฟตแวรสามารถตรวจจับไดเพียงไฟหนาของยานพาหนะดังรูปท่ี 4.17 ถาแสงสวางเพียงพอ

ซอฟตแวรสามารถตรวจจับยานพาหนะไดทั้งคนัดังรูปที่ 4.16  
 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 
 

 

บทท่ี 5  

สรุปผลการวิจัยและขอเสนอแนะ  
 

5.1 สรุปผลการวิจัย  

ซอฟตแวรสามารถนําเขาขอมูลวิดีโอสตรีมจากกลองเว็บแคม นํามาผานการประมวลผลและ

วิเคราะหรูปภาพ เพื่อคํานวณความเร็วและนับจํานวนของยานพาหนะที่ผานพ้ืนที่สําหรับวัดความเร็วได มุม

ที่ใชในการติดตั้งกลองเว็บแคมคือ 70 องศา ซึ่งจากผลทดลองทําใหทราบวาเปนมุมที่มีความคลาดเคลื่อน

ของความเร็วยานพานะนอยที่สุด ซึ่งคลาดเคลื่อน ± 2 km/hr ในสวนของการทดลองการตรวจจับ

ความเร็วยานพาหนะประเภทตางๆ ทําใหทราบวาสามารถตรวจจับยานพาหนะไดหลากหลายประเภท เชน 

รถจักรยาน รถจักรยานยนต รถยนต รถตู และรถบรรทุก เปนตน ความหนวงเวลาของซอฟตแวรกับเวลา

จริงที่ยานพาหนะเคลื่อนที่มีความหนวงเวลาเฉลี่ยอยูที่ 1.0866 วินาที ซอฟตแวรนี้พัฒนาโดยการนํา 

Visual Studio และ Qt Creator พัฒนาในสวนของแอปพลิเคชันดวยภาษา C++ รวมกับไลบรารี 

OpenCV  

 

5.2 ขอจํากัดของปญหาพิเศษ 

1) ซอฟตแวรไมสามารถแสดงผลความเร็วหากวัตถุเขามายังกรอบพื้นที่ตรวจจับแลวออกจาก

กรอบทางดานขางของกรอบ หรือการที่ยานพาหนะมีการเปลี่ยนเลนขณะที่ทําการคํานวณ

ความเร็ว 

2) ซอฟตแวรจะทําการนับจํานวนของยานพาหนะผิดพลาดเมื่อวัตถุที่ผานเสนอางอิงไมใช

ยานพาหนะ เพราะซอฟตแวรมองทุกอยางที่เคลื่อนไหวเปนวัตถุ 

 

5.3 ขอเสนอแนะ 

1) พัฒนาซอฟตแวรใหสามารถทําการแยกประเภทของยานพาหนะได 

2) พัฒนาซอฟตแวรใหมีความแมนยํามากยิ่งข้ึน 
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ภาคผนวก ก 

วิธีติดตั้งไลบรารี OpenCV สําหรับใชงานภาษา C++ 
 

 วิธีการติดตั้งไลบรารี OpenCV สําหรับใชงานในภาษา C++ เพื่อพัฒนาแอปพลิเคชันดาน

คอมพิวเตอรวิชัน มีขั้นตอนดังนี้ 

1) ทําการดาวนโหลดไฟลไลบรารี OpenCV ท่ีเว็บไซต http://opencv.org/releases.html 

โดยใหเลือก OpenCV สําหรับ Windows แสดงดังรูปที่ ก.1 

 

รูปท่ี ก.1 หนาตางของเว็บไซตสําหรับดาวโหลดไลบรารี OpenCV 
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2) เมื่อทําการโหลดเรียบรอยแลว ใหสรางโฟลเดอร  "C:\OpenCV-X.X.X" สําหรับเวอรชัน 

OpenCV ตัวอยางเชน "C:\OpenCV-3.2.0" แสดงดังรูปที่ ก.2 

 

 
 

รูปท่ี ก.2 หนาตางไดร C ที่ทําการสรางโฟลเดอรของไลบรารี OpenCV 

 

 

3) ทําการติดตั้งไลบรารี OpenCV ที่ดาวนโหลดมา และเลือกติดตั้ งไลบรารีที่ โฟลเดอร 

"C:\OpenCV-3.2.0" แสดงดังรูปที่ ก.3 

 

 
 

รูปท่ี ก.3 การกําหนดโฟลเดอรสําหรับการตดิตั้งไลบรารี OpenCV 
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4) ทําการเพ่ิมไดเรคทอรี่ bin ของ OpenCV ไปยัง PATH:  

ตัวอยาง เชน ถาใช OpenCV 3.2.0 และ Visual Studio 2015 ใหทําการเพิ่มไดเรคทอรี่ 

C:\OpenCV-3.2.0\opencv\build\x64\vc14\bin ไปยัง PATH: ดังรูปที่ ก.4 

 

 
 

รูปท่ี ก.4 การเพ่ิมไดเรคทอรี่ bin ไปยัง PATH: 
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ภาคผนวก ข 

วิธีการทดสอบไลบรารี OpenCV รวมกับโปรแกรม Visual Studio 

บนระบบปฏิบัติการ Windows 
 

การทดสอบไลบรารี OpenCV รวมกับโปรแกรม Visual Studio บนระบบปฏิบัติการ Windows

ขั้นตอนแรกเปดโปรแกรม Visual Studio -> Choose File -> New -> Project ดังรูปที่ ข.1 

 

รูปท่ี ข.1 การสรางโปรเจคในโปรแกรม Visual Studio 

 

จากรูปที่ ข.1 หลังจากคลิ๊กเขาไปท่ี Project แลวโปรแกรม Visual Studio จะเปลี่ยนหนาตางไป

เปนหนาตางสําหรับเลือกประเภทโปรเจควาจะพัฒนาโปรแกรมดวยภาษาอะไร ในที่นี้เลือก Visual C++ 

โดยทําการเลือก Visual C++ -> Empty Project -> แลวทําการตั้งชื่อโปรเจค แสดงดังรูปที่ ข.2 
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รูปท่ี ข.2 การสรางโปรเจคและกําหนดชื่อโปรเจคในโปรแกรม Visual Studio 

 

 

จากรูปที่ ข.2 หลังจากทําการสรางโปรเจคสําหรับพัฒนาโปรแกรมแลว ข้ันตอนตอไปตองทําการ

สราง C++ File สําหรับเขียนโปรแกรมเพ่ือควบคุมการทํางานของโปรแกรม วิธีการสราง C++ File ใหทํา

การคลิ๊กขวาท่ี Solution Explorer -> Choose Add -> New Item -> Choose C++ File  และทําการ

ตั้งชื่อไฟลของ C++ แลวกด Add แสดงดังภาพที่ ข.3 
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1)   

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี ข.3 การสราง C++ File และกําหนดชื่อ C++ File ในโปรแกรม Visual Studio 

 

จากนั้นใหทําการเขียนโปรแกรมดวยภาษา C++ เพื่อทดสอบโปรแกรมและไลบรารี OpenCV ใน

ที่นี้จะทําการเขียนโปรแกรมเพ่ือ Subtraction Background ของภาพ แสดงดังรูปที่ ข.4 
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รูปท่ี ข.4 ภาพการเขียนโปรแกรมเพ่ือ Subtraction Background ของภาพ 

 

จากรูปที่ ข.4 หลังจากเขียนโปรแกรมใหเปนไปตามที่ตองการแลว ตอมาทําการเพ่ิมไลบรารี 

OpenCV ลงไปในโปรแกรมที่กําลังพัฒนา โดยในที่นี้จะตั้งคา Solution Configurations เปน Debug 

และ Solution Platforms เปน x64 หลังจากนั้น ไปที่  Project -> (project name) Properties -> 

Configuration Properties -> VC++ Directories -> Include Directories เพ่ือทําการเพ่ิม Include 

Directories ของไลบรารี OpenCV ตัวอยางเชน "C:\OpenCV-3.2.0\opencv\build\include" แสดงดัง

รูปที่ ข.5 
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รูปท่ี ข.5 การเพ่ิม Include Directories ของไลบรารี OpenCV ใน Visual Studio 

 

จากภาพที่  ข.5 หลังจากเพ่ิม Include Directories เสร็จแลว ข้ันตอนตอไปตองทําการเพ่ิม 

Library Directories ข อ ง ไล บ รารี  OpenCV โด ย ไป ที่  Project -> Properties -> Configuration 

Properties -> VC++ Directories -> Library Directories แสดงดังรูปที่ ข.6 
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รูปท่ี ข.6 การเพ่ิม Library Directories ของไลบราร ีOpenCV ใน Visual Studio 

 

จากรูป ท่ี  ข.6 หลังจากทําการเพิ่ม Library Directories ของไลบรารี OpenCV ใน Visual 

Studio แลว จากนั้นทําการเพ่ิม Debug Library โดยไปที่  Project -> Properties -> Configuration 

Properties -> Linker -> Input -> Additional Dependencies แ ล ว เ ลื อ ก ตั ว  Debug Library        

ชื่อ opencv_world320d.lib แสดงดังภาพที่ ข.7 
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รูปท่ี ข.7 การเพ่ิม Debug Library ของไลบราร ีOpenCV ใน Visual Studio 

 

จากรูปที่ ข.7 หลังจากเพ่ิม Debug Library ของไลบรารี OpenCV แลว ทําการรันโปรแกรมที่

เตรียมไวจะไดผลลัพทแสดงดังภาพที่ ข.8 

 

 

 

 

 

 

 

 

 

 

รูปท่ี ข.8 ผลลัพธการ Subtraction Background รูปภาพ โดยใชไลบรารีของ OpenCV 
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ภาคผนวก ค 

การสรางโปรเจคในโปรแกรม Qt Creator 

 
การสรางโปรเจคในโปรแกรม Qt Creator ขั้นตอนแรกเปดโปรแกรม Qt Creator-> File-> 

New File or Project-> Project ดังรูปทีค.1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี ค.1 การสรางโปรเจคในโปรแกรม Qt Creator 
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 จากรูปที่ ค.1 หลังจากสรางโปรเจคเสร็จแลว ขั้นตอนตอไปคือการติดตั้งไลบรารี OpenCV 

บน Qt Creator โดยใหไปตั้งคาที่ไฟลนามสกุล .pro ดังรูปที่ ค.2 

 

 

 

 

 

 

 

 

 

รูปท่ี ค.2 ไฟลนามสกุล .pro สําหรับเพ่ิมคําสั่งใชงานไลบรารี OpenCV 

 

 จากรูปที่ ค.2 หลังจากเขาไปที่ไฟลนามสกุล .pro แลว ใหทําการตั้งคา Include Directories 

โดยการเพ่ิมคาํสั่ง INCLUDEPATH +=(ใส include path) ดังรูปที่ ค.3 

 

 

 

 

รูปท่ี ค.3 การตั้งคา Include Directories ของไลบรารี OpenCV บน Qt Creator 

 

จากรูปที่ ค.3 หลังจากทําการตั้งคา Include Directories ของไลบรารี OpenCV บน Qt 

Creator แลว ขั้นตอนตอไปใหเพ่ิมคําสั่ง LIBS +=-L(ใส library path) เพ่ือเปนการตั้งคาไดเรคทอรี่

ของไลบรารี OpenCV ดังรูปที่ ค.4 
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รูปท่ี ค.4 การตั้งคา Library Directories ของไลบรารี OpenCV บน Qt Creator 
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ภาคผนวก ง 

ผลงานที่ไดรับรางวัล 
 

ง.1 เขารวมงาน Aucc-2017 

ผูจัดทําไดเขารวมงานประชุมวิชาการระดับปริญญาตรีดานคอมพิวเตอรภูมิภาคอาเซียน 

(The 5 th ASEAN Undergraduate Conference in Computing : AUCC ) ครั้ งที่  5 โดยงาน

ประชุมเชิงวิชาการนี้จัดขึ้นระหวางวันที่ 21 เมษายน ถึงวันท่ี 22 เมษายน 2560 ณ มหาวิทยาลัย

นเรศวร จังหวัดพิษณุโลก มีมหาวิทยาลัยเขารวมมากกวา 30 สถาบัน สําหรับปญหาพิเศษนี้ไดรับ

รางวัลเปเปอรระดับด ี(Good Paper) ดังรูปที่ ง.1 และรูปที่ ง.2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี ง.1 เขารวมงาน AUCC-2017 
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รูปท่ี ง.2 เกียรติบัตรที่ไดรับจากการนําเสนอผลงาน 

 

ง.2 ผลงานตีพิมพ 
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